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Package Contents

Contents of Package:

B D-Link DP-301P+
Pocket Size Print Server

B Manual and Warranty on CD
B Printed Quick Installation Guide

If any of the above items are missing, please contact your reseller.
System Requirements:

A computer with an installed Ethernet adapter

Windows XP/2000/NT4/Me/98SE

Apple Mac OS with AppleTalk

Linux

NetWare 5.x or above (Native NDS)

Internet Explorer 6.0, or Netscape Navigator version 6.0 or above,
with JavaScript enabled

Printer must support required Operating System
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Introduction

The D-Link DP-301P+ Print Server is a pocket size print server that connects to
your Ethernet/Fast Ethernet network anywhere you wish to locate printer services.
The DP-301P+ manages the flow of print files from workstations or file servers to
connected printers, delivering print jobs to printers much faster than a file server or
a PC acting as a print server.

The DP-301P+ includes easy-to-use software to install on most Windows-based
networks. Protocol support for TCP/IP, NetBEUI, and AppleTalk are provided to
ensure seamless connection to major networking operating systems.

The DP-301P+ has a built in Web-based management feature that allows users to
easily configure and manage multiple print gueues through TCP/IP. The DP-301P+
also supports Telnet as an alternative method to configure the unit.

The DP-301P+ improves network printing services in the following ways:

| The DP-301P+ manages print file traffic. This provides workload relief
to your file servers, and allows the file servers’ full capacity to be used
for file access or other direct services to network users. On Peer-to-
Peer networks, workstations can print directly to the print server
without increasing the load of another workstation or server.

| Because the DP-301P+ is very portable and inexpensive compared to
a PC-based print server, and the print server connects to your file
servers through the network, printers can be deployed to locations of
maximum convenience to users.



The DP-301P+ offers extraordinary flexibility, operating with all major network
operating systems and protocols:

u TCP/IP

UNIX Ipr/lpd (HP-UX, Sun OS, Solaris, SCO, UnixWare, IBM AIX)
Windows NT/2000, Windows 95/98SE/Me, Windows XP
NetWare 5.x NDPS LPR Remote Printing

[ NetBEUI

Windows NT/2000/XP, Windows 95/98SE/Me, Windows for Workgroups,
Microsoft LAN Manager, IBM LAN Server

| AppleTalk

Mac OS EtherTalk

Windows-based setup and administration software, PS Admin, is supplied with the
print server, making configuration and management quick and easy. The print
server also supports configuration and management via the Telnet protocol for
networks without Windows-compatible machines.

External Features

Port Connectors

The DP-301P+'s parallel port is located on its front panel. The port can be
configured using the PS Admin program or the print server’s Telnet interface. (See
the PS Admin User’s Guide, available on the CD that came with the DP-301P+, for
information about configuring the print server’s ports.) The print server also
supports web configuration permitting users to configure settings through the web
browser. The default IP address is as follows:

| Default IP address —192.168.0.10

| Subnet mask — 255.255.255.0

Note:

The PC’s IP address must be in the same subnet as the print server’s IP address for the
two devices to communicate. (For example, if your print server's IP address is
192.168.0.10, with a subnet mask of 255.255.255.0, then your computer’s IP address
should be 192.168.0.x, where x is a value between 1-254, excluding 10.)




Rear Panel

Ethernet

Port
LEDs ACT LET]O OC©
W s YA

Power

Ethernet Port - Network Cable Connector

The print server’s rear panel features an RJ-45 connector for connection to
10Base-T Ethernet cabling or 100Base-TX Fast Ethernet cabling (which should be
CATS5 twisted-pair cable). The port supports the NWay protocol, allowing the print
server to automatically detect or negotiate the transmission speed of the network.
Use this port to connect to your network router.

Power - DC Power Connector

The DC power input connector is located on the print server’s rear panel .

LED Indicators

The back panel of the print server features three LED indicators:
ACT - Lights up to indicate activity on the network.

LPT - Lights up to indicate printing activity.

@ - Lights up to indicate that the DP-301P+ is powered ON.



Front Panel

Parallel Port Connector

The front panel of the print server features the parallel port connector. Plug this
connector directly into the parallel port on your network printer. There is no need for
a parallel port cable between the print server and your network printer.



Setting up the DP-301P+

Installing the Print Server

up without first establishing its network connection. Follow this procedure to

Q WARNING: Configuration problems may result if the print server is powered
avoid complications at the configuration stage.

1. Confirm proper operation of the printers to be connected to the DP-301P+.

2. When you have confirmed proper operation of the printer, switch its power

3. Confirm that your network is operating normally.

4. Connect the DP-301P+ RJ-45 Connector to the network, using an Ethernet
CATS5 cable.

5. While the printer is powered OFF, install the DP-301P+ parallel port connector
into the parallel port on the network printer.

6. Switch on the connected printer.

7. Plug the AC power adapter’s DC output plug into the DC 5V power socket on
the print server.

8. Plug the power adapter into a power outlet. This will supply power to the print
server, as it has no external power switch. The green Power LED on the Print
Server’s front panel should illuminate steadily, and the Print Server’s Self-Test
will proceed.

Power ON Self-Test

Every DP-301P+ has been factory-tested to operate properly.

Whenever the DP-301P+ is powered up, two testing procedures follow
automatically. The first procedure is a programmed series of flashes intended to
confirm proper operation of the LED indicators. The second procedure comprises
programmed tests of the DP-301P+’s internal circuitry. If any fault is found during
the circuitry tests, testing stops and a continuous pattern of flashes signals the
nature of the fault.



Indicator Test

Immediately upon power-up, the@ (Power) and LPT indicators will illuminate
steadily in green for several seconds. Then the LPT indicator will become dar
while the (Power) indicator remains steady. Irregularity of any indicator during
this test indicates that there is a problem with the indicators themselves.

Circuit Tests

The circuit tests immediately follow the indicator test. A normal (no fault) result is
signaled by three flashes of the LPT indicator and the start of normal print server
operation. If any error condition is found during the circuit tests, testing will halt with
the LPT indicator continuously signaling the particular error according to the
following table:

LPT LED Flash Pattern Error Type

Steady long flashes Firmware Reload Required
Continuously on DRAM Error

One long, two short flashes Timer INT error
One long, three short flashes Flash Protected
One long, five short flashes Flash Erase/Program error
One long, six short flashes LAN Controller error

One long, eight short flashes Parallel Controller Error
One long, nine short flashes LPT Error
One long, fourteen short flashes LAN PHY error

In the event of a Firmware Reload Required error at startup, proceed according to
instructions given in the PS Admin User’'s Guide (“PS Admin Administration”
section, under the heading “Upgrading the Print Server’s Internal Firmware”).

The PS Admin software includes a Print Test function for confirmation of print server connections and
functions. This operational test can be performed after you have installed the PS Admin software and
completed the PS Admin procedures for configuring the DP-301P+. See the instructions given in the PS Admin
Users Guide (“Getting Started Setting up Your Print Server” section, under the heading “Testing your Print
Server”).



Getting Started

Below is a sample network using the DP-301P+. The DP-301P+ has a built-
in Web-based management feature that allows users to easily configure
and manage multiple print queues through TCP/IP.

Computer 2

Desktop PC or Laptop

¢ Cable/DSL Modem

Computer 1 S

Desktop PC or Laptop

For a list of printers that are compatible with the DP-301P+, please see the
Appendix in this manual. The compatibility list is not comprehensive. Even if it
is not included in the list, your printer may be compatible with the DP-301P+.
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Using the Web Configuration

Open your web browser and type http://
192.168.0.10 in the address bOX, and press File Edit View Faworites  Tools  Held
Enter. This set of numbers is the default IP _ 2
address of your print server. Please note that Que - © ¥ EG
the PC’s IP address must correspond with | sidees &) hitp://192.168.0.10

the print server’s IP address in the same
segment for the two devices to
communicate.

Home > System
Device Status D-Link

Burilding NeTworks for People DP-201P+

This tab displays the system Pocket Size Print Server
information, providing general ( (PSS Configurationd  Tools | Help

information regarding the print
server. Click on the Refresh
button to acquire the most Syoom Cllbos 3 kit
updated information. Once a - st

. . . Herwark Prihes Stams
printer is connected to the print e
rr— Printer Speed High

server, the Printer Status will
be dlsplayed_ Tatal Print Jogs 0

Tokal Print Sz 0 kBs

Enrver Hamn FESGHO1
Wodel OP-301P+
Flimmaea Varsion 200 (0405-06)

Server Name: The name

Nams

assigned to the print server. s

[
Proocol

Model: The model of the print Gt - oom
server.

Etsenit Status
Link Yes

Hardware Version: The st
version of the hardware on the
print server.

Rx Errors o

Firmware Version: The version -

, @
of the firmware and release date satresn
on the print server.

MAC Address: The MAC address of the Ethernet port.
IP Address: The IP address of the print server.
Up Time: The length of time the print server has been up.

This screen also displays information about the Printer Status and the Ethernet
Status.
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Using the Web Configuration (continued)

This screen contains
information regarding Auto IP,
TCP/IP Printing, Microsoft
Network Printing, and MAC
AppleTalk Printing.

This screen displays the
User’s Printing Log.

Home > Network
D-Link

Buridting Metworks for People

DP-301P+
Pocket Size Print Server

;- Home Configuration Tools m
":'? Auta 1P
L DHEPBOGTE Disatle F . 0.0.000
¥ uFre Enable (P 1921680181
MAL Randezvus Enable 0P 165 354 33 0%
rE=m—
e
LPR Printisg Status Runsing
Total Prinl Jobs 0
Total Print Stz 0Ky
Bor (3100) Pricting Status Furrerg
5 ’
V ik Tota Pt Jobs 0
Tetal Print iz 0 kEnes
1P Printing Status Rureing
Total PrntJobs < 0
Total Print Szn 0 kEins
FT# Printeg Statys Ruyrring
TotalPrintJobs < 0
Total Piint 28 0 kEytes
Fmail Frinting Btalus Rursing
TowPintJobs 0
Total Print Size. OHames
i osuft Hetwark Printing
SN (Cver NEWELD Printng status Rureing
Tots PrintJobs < 0
Tetal Print iz 0 kEes
S (Cver MET) Brinting Stalus Risasig
Total PrintJobs 0
Total Print Seze [T
AL Apple Talk Printing
ApplaTat Frinting Stahis Runsing
TotaPintjobs 0
Total Print Size 0 Kiytes
|

Home > User
D-Link

Building Metworks for Feople DP-301P+
Pocket Size Print Server

g (U Confgurationd _Too's | __Help_J

Users Printing Log

MAC ¥ Py Jobs  SuenEes

Srdn <

Rofrech

Hetwork




Using the Web Configuration (continued)

Configuration > System

D - ] i
Building H!:on!kslt}&oﬂe DP-301P+
Pocket Size Print Server

MEC]  Tools | Help

v

el . Systemn Device
e ———
"h«@ Server Name © |P3-5321D1 |
Location ‘ ‘
Admin Cortact 4 |
System B —
Password T MewPassword -
Confirm Again - ‘ \
! e — —
Network
Port Setting
-— LPT Port Name |PEEa21D1-P1 |
User
" Description . ‘ ‘
o — Speed : ‘High v|
SNMP —
PL Printer :[No ¥
2 9
Apply Cancel

The Configuration window will display the settings required to configure the DP-
301P+ Print Server. Consult your printer's manual for the PJL (Printer Job Lan-
guage) and print speed supported on your printer. Click Save on the bottom of the
configuration page to ensure the settings are updated and saved.

Server Name: The name assigned to the print server.
Location: Input a comment indicating where the print server is located. (optional)
Admin Contact: The name of the print server’s administrator. (optional)

Password: By default the DP-301P+ does not have a password. For security, you
may wish to enter a password.

Port Name: This is the assigned name for the parallel port.
Description: A brief description for the parallel port. (optional)
Speed: Select high or low printer port speed.

PJL Printer: This feature is used to support the Hewlett-Packard PJL (Printer Job
Language) standard for bi-directional printing.
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Using the Web Configuration (continued)

Configuration > Network

D-Link

Building Networks for People

DP-301P+
Pocket Size Print Server

’ m Configuration Tools m
,f"‘e : TCPAP
k“ﬁ? IP Address : ;_@ Manually Assign

IP Address S| 192.168.010
SubnetMask . |255 255 25610 |
System e
Diefault Gatewsay - 0.0.0.0

d
£,

| © Autornatically Assign

= DMS Serveraddress @ 4 [pnpq
z.|0.0.00

—
ul : ®Enab|e ODisable

MAC Rendezvous . @ Enable O Disable

SNMP Second HTTR Port O Enable @ Disable
Fort Murmber « |0

(For Remote We_b Canfiguration and IPP Printing)

Network

Microsoft Metwork

Workaraup - [WORKGROURP |

AppleTalk

AppleTalk Zone £ i*

LFT © Chooser Mame D PE-5921D1-P1

Printer Type ; -Laser‘\f\u’riter i
PostScript Level . |Level 2 V|

Fant Group : |Standarcﬁ5_\'I

2 O

Apply Cancel
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Using the Web Configuration (continued)
Configuration > Network (continued)

TCPI/IP Protocol

IP Address
Manually Assign: To manually assign an IP address please provide the

following information:

IP Address: The default IP address is 192.168.0.10
Subnet Mask: The default subnet mask is 255.255.255.0
Default Gateway: Enter the IP address of the default gateway

(router).
Automatically Assign: Select this option to receive an IP address auto-

matically.
DNS Server Address: A Domain Name Server (DNS) translates a domain
name into an IP address. Enter the IP address of the DNS server here.
UPNP: Enable UPnP (Universal Plug and Play ) here. UPnP makes installation
easier if all the communicating devices also have UPnP enabled.

MAC Rendevous: Select Enable for ease of use with Mac OS X computers.

Second HTTP Port: Select Enable and enter a Port Number for remote web con-
figuration and IPP Printing. (IPP is a Web-based printer management)

Microsoft Network

Workgroup: Computers in the same network must have the same
Workgroup name.

AppleTalk

AppleTalk Zone: Enter an asterisk.

Chooser Name: Enter the printer name.

LPT Printer Type: Enter the printer type.
PostScript Level: Enter the PostScript level.
Font Group: Enter the font group.

Save: Click Apply to save the changes.
15



Using the Web Configuration (continued)

Configuration > User

D-Link

Building Networks for People DP-301P+
Pocket Size Print Server

M' Configuration m

Printing Control
Enable User Printing Contral D Oives @No a a

Apply Cancel

System Define Users

Add User : UserMame : | | [ Add ]

Nediari MAC Address ¢ | |

{Exarnple 00 80 CF A1 B2 O3

-

Printing Access  © ®ves Mo
m Delete User
-

User List ; ! | Narne EMAC |PrmtingAccess |

Printing Control

Enable User Printing Control: To control access to the printer click Enable.

Define Users

Add User: Enter the User Name, the MAC Address, click Yes or No for Print-
ing Access and then click Add.

User List: You can delete a user in the list by putting a check in the box to the left
of the name and clicking Delete.

16



Using the Web Configuration (continued)

Configuration > SNMP
D-Link

Buriliting Hetwarks for Frople DP-301P+
Pochket Size Print Server

Configure your SNMP here. g LT Toos_|_tep__
Managemer

Community!  Mame public

R

Q\
!

Atcess Right Fiead/iite »

Communty2  Mame
System
Access Right | Flesd Oriy %

Communty 3 Harruy
r ..
o—— AccessFighl | Read Only w

User a eB

1]

Tools > Print Test
D-Link

BUilding NETworks for People DP-201P+
Pocket Size Print Server

6 [__rome | configuration RIS Help |

Click Apply to print a test uf e
A @ LPT
page.

2
- - Apply




Using the Web Configuration (continued)

Email Account:
Configure the Print
Server's email ac-
count here.

Email Notification:
Click Yes to enable
email notification for
printer status change.

Test: Click Test to
send an email to the
Admin account.

Email printing: Click
Yes to enable email
printing. (only the text)

Receive email
interval: Enter the
length of time be-
tween emails here.

Receive: Click
Receive to get
emails and printouts.

Reset: Click Apply to
reset the DP-301P+.

Factory Reset: Click
Apply to reset the DP-
301P+ to the factory
default settings.

You will
& lose your
current

settings if you Reset
the DP-301P+.

Tools > Emaiil
D-Link

Building Networks for People DP-301P+
Pocket Size Print Server

- Configuration SR SN Help |
‘\é
by

E-mail Account

Print Server E-mail Address k \ ‘

Incoming E-mail (POP3) Server Address

Print Test Outgoing E-rmail (SMTF) Server Address

\
\

Account Mame ‘- ‘
L

E-mail Password :

|
9 <

Reset Apply Cancel

E-mail Notification
Upgrade Enable e-mail notification for printer status changing © O ves @ nNo

Admin E-mail Address ‘

{Use ''to separate multiple e-mail address)

gl

Backup
2 0
Apply Cancel
E-mail testwill send an e-mail to Admin's e-mail address
Doyouwant to test e-mail account?
E-mail Printing
E-rmail Printing © @Enable O Disable
Receive E-mail Interval ‘15 I(mmutgs)
2 9
Apply Cancel
Do youwant to receive e-mail and print out?

Tools > Reset
D-Link

Building Networks for People DP-301P+
Pocket Size Print Server

- |__Home I Configuration JRNNRCINN  Help |
\.\_“_ !'1
¥

Reset
Do you want o reset this deviee?

@

Apply
Print Test
Factory Reset

D you want to restore this device to factory default setting?

E-mail a

Apply

Upgrade

Backup

QR

18




Using the Web Configuration (continued)

Firmware Upgrade:
Visit the D-Link support
site at http:/
support.dlink.com to find
the latest firmware
upgrade. Copy it to your
hard drive.Then click
Browse in this window
to select the upgrade
and click Apply. Your
firmware upgrade is
complete.

Backup Device
Configuration to File:
Click Apply to make a
backup copy of your
current configuration.

Restore Device
Configuration from
File: Click Browse to
browse your hard drive
for backup configuration
files. After you have
selected a file click

Apply.

Tools > Upgrade

D-Link

Building Networks for People DP-301P+

S "
'
g %
-

E-mail
=

Pocket Size Print Server

|__Home 1 Configuration SRS Help

Upgrade
Mote: Please make sure that you use the correct firmware hefore you proceed. [fyou do not
know which firrmware you should use, please contactyour local dealer for technical support.

Current Firrware Yersion and Date: 3.00¢ (2004-02-06)

Select A Firmware File : | |CBrowse... ]

2 9

Apply Cancel

Tools > Backup
D-Link

Building Networks for People DP-301P+

L
s
7

o
Print Test
T =
E-mail

—

Reset

—
Upgrade

Pocket Size Print Server

|__Home I Configuration JRRRCTRNN  Help |

Backup Device Configuration to File
Do you want to backup the configuration to file?

Apply
Restore Device Configuration from File
Select A Configuration File : |(Browse.. ||
Apply Cancel
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Using the Web Configuration (continued)

Help

D > ] ;
Building u!do!kslf}hopte DP-301P+
Pocket Size Print Server

Help

Uy . £ Help

)8 For US customer support, please visit us online at hitpfsuppaort. dlink.com

Home
Swystern
Metwork
User

Configuration
Swystern
Metwork

User

SHMP

Tools
Frint Test
E-rmail
Reset
Upgrade
Backup

Help: Click on any item in the Help menu for more information.
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TCP/IP Printing for Windows XP

Open the web browser, and type in the IP address of the DP-301P+.
Type http://192.168.0.10 into the Location or Address field. Press Enter.

Note:

The PC’s IP address must be in the same subnet as the print server’s IP
address for the two devices to communicate. (For example, if your print
server’s |IP address is 192.168.0.10, with a subnet mask of 255.255.255.0,
then your computer’s IP address should be 192.168.0.x, where x is a value
between 1-254, excluding 10.) See Networking Basics: Assigning a Static IP
Address in this manual to find out how to change an IP address.

File Edit ‘“ew Favorites Tools  Help

Qo= - @ - [¥] ] &

Address | ] http://192.168.0.10

DP-301P+
Pocket Size Print Server

( ) Home M-M
o ‘? -

Total Print Joss ]
Tokal Print ize. kB

Frinting Size D

TuFagkets

21



TCP/IP Printing for Windows XP (continued)

At the Configuration window, write down the Port Name for future reference.
You will need this information later in the configuration process.

D-Link

Building Networks for People

DP-301P+
Pocket Size Print Server

“ C Home RN toos o Hep

Y
iy "':e g System Device B
: "‘;h_l"a Server Marme : [E—SE@_‘I |
I Location : | |
- Admin Contact : | |
wem~ . Password o Mew Password -

Confirm Again - | |
P s T
Network
: PortName - |PS-5921D1-F1
User
Description :
BT Speed | High »
SHMP E
PJL Printer :[No ¥

9 9

Apply Cancel
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TCP/IP Printing for Windows XP (continued)

When you select TCP/IP Protocol at the Network window, the screen below
appears. (We recommend that you keep the default settings as shown.) If you
need to make changes, make sure to click Save after you have made the
changes. (You may wish to make a note of the IP address.)

D-Link e

Pocket Size Print Server

> Configuration [ECETSNR T

TCPAP

i IP Add [ :
s ress @ Manually Assign

IP Address | 182.168.0.10
—

SubnetMask - |255 2552550 |
Network

Default Gateway - |0.0.0.0

| O Automatically Assign

4. [0.000
e
210,000
ou—— L
UFPhP ¢ @ Enable O Disakble

MAC Rendezvous @ Enable O Disable
—
SHMP

DMS Server Address

Second HTTF Port O Enable @ Disable

Port Nurnber '_U
(Far Remate Yweb Configuration and IPP Printing)

Microsoft Network

Warkgraup . [woRKGROUP

AppleTalk

AppleTalk Zone £ |* |

LPT : Chooser Mame T PS-5921D1-F1
Printer Type : -I-_gfil\-’_riter 1
PastScript Level | Level 2 VI
Fant Group [Standard 35 v

@

g

Apply Cancel
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TCP/IP Printing for Windows XP (continued)

Go to Start > Settings >

Printers and Faxes > Printer Tasks
Add a Printer.

'ﬂ Add a prinker

Add Printer Wizard Ji

[

Welcome to the Add Printer
@ Wizard

Thiz wizard helps pou instzll 2 printer of make panter
conneclions.

i If you have 2 Plug and Flay penter that comects

\/ through 2 USB port [or any ctner hot plugoable
poit, 2uch a2 IEEE 1334, infrared, and 20 on). you
do nct need 1o uze this wizard, Clck Cancelto
clese the wizard, and then plug the penter’s cable
into your computer o poink the penter toward your
computer's infrared poet, and lum the penter on
Windows wil automatizaly instal the printer for you

Tocortnue, chck Neat

Cancal

Click Next.
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TCP/IP Printing for Windows XP (continued)

Add Printer Wizard i

Local or Network Printer

Select Local Prl nter . The wizard needs to know which type of printer to set up,

Select the option that describes the printer you want to uze:

& Lacal printer attached to this computer

DeseleCt A u tO m atl Ca.l |y ™ Awtomaticaly detect and install rmy Plug and Play printer
d eteCt an d | n Stal | my & netwark printer. or a printer attached to another compter
Plug and Play printer.

2 4 Tosetup a netwark printer that is not attached ta & print server,
\:5;) uge the "Local printer'’ option

Click Next.

2= -

Add Printer rd I

Select a Printer Port
Computers communicate with printers through ports.

Select the port you want vour printer to use. [f the part is nat listed, you can create a

rew part.
SeleCt Create a new pO rt . At the " Use the follwing port ILF'TT: [Recommendsd Printer Port] Li
pU”-dOWI’\ menu, hlghllght Mite: Most computers use the LPTH: port to communicate with alocal grnter

Tihe connector for thiz part shauld ook something lilke this:

Standard TCP/IP Port.

% Create a new port

Click Next. Type of part

< Back '@ Nest > il Cancel |

Add Standard TCP/IP er Port Wizard x|

Welcome to the Add Standard
TCP/IP Printer Port Wizard

‘Y'ou uge this wizard to add & port for a netwark, printer.

Biefore continuing be sure that:
he device is tuned on,
2. The network. is connected and configured.

Click Next.

To continug, click Next.

Cancel
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TCP/IP Printing for Windows XP (continued)

Add Standard TCP/IP Printer Port Wizard N _ﬂ

Add Port
Far which device do you want to add a port?

Typeinthe IP
address Of the Enter the Printer Mame or IP address. and a port name for the desired device.
print server (i.e.
192.168.0.10).

Prirter Mame or IP Address: |192.155.U.1U

Port Mame: IIPJ 92.168.0.10
The Port Name
will automatically
be filled in.
< Back | MNext > Cancel |

Add Standard TCP/IP Printer Port Wizard N

Additional Port Information Required
The device could not be identified

The device is not found on the netwark. Be sure that:

1. The device is turned on.

2. The network is connected.

3. The device iz properly configured.

4. The address on the previous page iz comect,

If wou thinks the address iz not conect. click Back to retumn to the previous page. Then corect
the address and perform another search on the network. IF you are sure the addiess is conect,
select the device type below.

Select Standard.

Device T

% Standard JiE} '

" Custom Settings. |

C“Ck NeXt < Back ' Mt > . Cancel |

Add Standard TCP/IP Printer Port Wizard x|

‘ Completing the Add Standard
TCP/IP Printer Port Wizard

—
“fou have selected a port with the following characternistics.

SHMP: Mo

Protocol: R, Port 3100
Device: 132.168.0.10

Part Marme: IP_192.168.0.10
Adapter Type: Genenic Network Card

To complete this wizard, click Finigh,

C“Ck FInISh Cancel
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TCP/IP Printing for Windows XP (continued)

Highlight the printer, as shown.

If the desired printer is not on Install Pinter Software
. . . The manufacturer and model determine which printer software to use.
the list, click Have Disk and t ‘ P ast
insert the printer driver disk that (D o e o s bt
came with your printer to install SRR

the printer drivers.

Manufacturer [=] [ Printess [+]

Fuiitsu i 5 HP LaserJet 3200 Series PCL

GEL S HP Laserlet 3200 Series PS

Generic 5 el

a S HP Laserlat 4

estether 2 "

HE ZaFHP Laserlet 4000 Series PEL

. Bl o ocoooe =l
3.}' Thiz driver is digitally signed windows Update Have Disk... |

Tell me why driver signing i important

Click Next.

Cancel |

Add Printer Wizard

Hame Your Printer
“Y'ou must assign a name to this printer.

At thlS Screen, you Can |nput a. name Type a name fn_r this printer. Because some programs do not support printer and server
. name combinations of more than 31 characters., it is best to keep the name as short as
for the printer. I
Erinter name:
HF Laser)et

Click Next.

< Back Ii Mext » I Cancel

e—

Add Printer Wizard

Print Test Page
Ta confirm that the printer is installed properly, you can print a test page v

Do you want to print & test page?
* es
Mo

Click Next.

< Back '@ Next » ! Cancel
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TCP/IP Printing for Windows XP (continued)

Add Printer Wizard

Completing the Add Printer
Wizard

You have successfully completed the Add Printer Wizard.
'ou specified the following printer settings:

Mame: Epson Stylus

Share name:  <Mat Shared:

Port; IP_192168.0.10

Model: Epson Stylus COLOR 740 ESC/P2
Default: Mo

Testpage: Mo

To cloge thiz wizard, click Finish.

Cancel |




TCP/IP Printing for Windows 2000

Open the web browser, and type in the IP address of the DP-301P+.
Type http://192.168.0.10 into the Location or Address field. Press Enter.

Note:

The PC's IP address must be in the same subnet as the print server’'s IP
address for the two devices to communicate. (For example, if your print
server’s IP address is 192.168.0.10, with a subnet mask of 255.255.255.0,
then your computer’s IP address should be 192.168.0.x, where X is a value
between 1-254, excluding 10.) See Networking Basics: Assigning a Static IP
Address in this manual to find out how to change an IP address.

File Edit Miew Faworites  Tools  Help

Q- © ¥ [ &

Address | ] hitp://192.168.0.10

D - l .
mmn!:t:n!u for Peogle DP-301F+
Pocket Size Print Server

( (OB Configurationd  Tools 4 Help
e

FESATION
DP.301PY

200c (004 05-08)
00 FF 1F %8 21 01

Syeiam P Adtress 192.162.0.10 Msnual
Up Timi 0 days, 0032580
T worwor Pomu—

LFT Printar Mamss PRARHOTF1
Printer Speed High
Printar Status OffEna

Prosorol

Spooang Sy e
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TCP/IP Printing for Windows 2000 (continued)

At the Configuration window, write down the Port Name for future reference.
You will need this information later in the configuration process.

D-Link

Building Networks for People

DP-301P+
Pocket Size Print Server

| Home MMOTITMECSM  Tools | Help

._j
o Y System Device
N T ————
“'ma Server Name ; [PS-EE@J |
Location : | |
Admin Contact : | |
Systemn —_—
- = FPassword o Mew Password -
Caonfirm Again : | |
’— S —
Network
Port Setting
LPT . PortNarme - |PS-5921D1-F1
User
Description : |
[ —— Speed ¢ | High [»
SHMP —
PLL Printer :[No |
Apply Cancel
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TCP/IP Printing for Windows 2000 (continued)

When you select TCP/IP Protocol at the Network window, the screen below
appears. (We recommend that you keep the default settings as shown.) If you
need to make changes, make sure to click Save after you have made the
changes. (You may wish to make a note of the IP address.)

D-Link

Building Networks for People

DP-301P+
Pocket Size Print Server

- Configuration [ECETINS NPT

el TCPAP
- IP Address

@ManuallyAssign

=) .
]
IP Address |182168.010
SubnetMask . |265.255.255.0 |
System —_—
Default Gateway - |0.0.0.0
| O automatically Assign

DME Server Address 1_50_0_0_0

Metwork

2 (0000 |
UPNhP . (@Enable O Disable
MAC Rendezvous . @ Enable O Disable
Second HTTF Port © (D Enable @Di_sable

Part Number : |0
(For Remote Web Configuration and IPP Printing)

Microsoft Network

Wiarkgroup -[woRKGROUP |

AppleTalk

AppleTalk Zone i

LPT : ChooserMame : PS-592101-P1
Printer Type : Iaser&rﬁter 1
PostSeript Level : ILeveIE v]
Font Group : ES@nd;i_S_S_Vi

9 ©

Apply Cancel
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TCP/IP Printing for Windows 2000 (continued)

Go to Start > Settings >

Printers | Ele Edl Yiew Go Favoies Heb
| &« . =» | Jd & BB B
: U = Ok Copy Pae

Double-click on the Add
Printer icon.

Im‘;l_d F‘rﬁer:.

& 3%

Add Piinler | HP Lasea)et
Seems |l

Printers

This folder contains information
about your current pnnters and a
wizard to help you install new
ones.

To get information about a
pnnter that's already installed,
nght-click the pnnter's icon.

To install 3 new pnnter, click Add
Printer to start the Add Printer
wizard,

Select an tem to view its
descniptian.

Add standard TCP/IP Printer Port Wizard N _ﬁ

‘ Welcome to the Add Standard
& TCP/IP Printer Port Wizard
“Y'ou uze thiz wizard to add a port for a network printer.
Before continuing be sure that:

1. The device is turned on.
2. The netwark iz connected and configured.

To continue, click MNest.

Click Next.

Caticel
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TCP/IP Printing for Windows 2000 (continued)

Select Local Printer.

Click Next.

Select Create a new port at the
pull-down menu,
highlight Standard TCP/IP Port.

Click Next.

Add Printer Wizard

Local or Network Printer
11 e prrer attached to o compuler

I thve: prinket it dioctly attacked compuler. chok Local ponter 1 £ &2 altached to
another comprter. amuu”.:madmm

 Yocu piried
¥ fuuscmaticaly detect anvd instal my P and Play pinter

" Ngiweek prrder

Add Printer Wizard

Hew Punter Deloction
Trus vozaed supomsiie ally desects and watalis rew Flug snd Play prosers

Windows was unabie to detect any Plug and Play printers. Click. Nese ¥ you
/ ! ard b0 install the printer merusely,

oo ([CHs5Y  coen |

Add Printer Wizard

Select the Printes Port
Comgulen: commurvcate win ponbes: theough ports
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TCP/IP Printing for Windows 2000 (continued)

Click Next.

Type in the IP address of the print
server in the Printer

Name or IP Address field. The
Port Name field will
automatically be filled in.

Click Next.

Select Standard.

Click Next.

Add Standard TCP/IP Printer Port ¥izard x|

wWelcome to the Add Standard
TCP/IP Printer Port Wizard

“'ou uge this wizard to add a port for a networl: printer.
Before continuing be sure that;

1. The devi .
2. The network 1z connected and configured.

To continue, click Next

< Back Cancel

Add Standard TCPAP Printer Port Wizard

Add Port L
For which device do you want to add a port? N

Erriter the Printer Name of P address. and a port name for the desired device.

Printet Name of IP Addess: 1921680010

Poit Name: 1P_192.168.0.10

Add Standard TCP/IP Printer Port Wizard El
Additional Port Inf o Reauied
The device could not be identified. =
N

The detected device it of unknown tppe. Be sure that:
1. The device is propesly configured.
2 The address on the previous page is correct

Either comect the address and perfiorm another search on the netwark by returning to the
peevious wizard page of select the device type if you are sure the address is comect.
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TCP/IP Printing for Windows 2000 (continued)

Click Finish.

Highlight the printer, as shown.
If the desired printer is not on
the list, click Have Disk and
insert the printer driver disk that
came with your printer to install
the printer drivers.

Click Next.

At this screen, you can input a
name for the printer.

Click Next.

inter Port Wizard

Add Standard TCP/]

Completing the Add Standard
TCP/IP Printer Port Wizard

ou have selected 5 port with the following characteristics.

SMMP: Ho

Protocal R, Paort 3100
Device: 1592.168.0.10

Part MName: IP_192.168.0.10
Adapter Type:  Generic Metwark Card

To complete this wizard, click Finish,

Cancel

Add Printer Wizard

Install Printer Software 7
The manudacturer and model determine which printer software to use. =

L4 Select the manufacturer and model of pour prntes. I yous printer came with an installation
1‘\? ek, click Have Disk. If pour printer iz not Ested, consult your prnter documentation for
compatible pinter software.

Marndacturer # | Printers s
Compaq % {E pson Styluz COLOR 740ESCP 2
33‘;‘.";”“" 55 Epson Stylus COLOR 780 ESC/P 2
Digtal 5 Epson Stylus COLOR 777 ESC/P 2
Epson v | | ¥ Epson Stylus COLOR 800 ESC/P 2 -

5 This ceiver is dighally signed. gmum' Have Disk... '
s i

< Back l! MNest » ' | Cancel
Add Printer Wizard

MName Your Printer

You must assign & name to this printer, @

Type a name fos this prnter. Becauss some programs do not support printes and server
name combinations of more than 31 characters, it is best o keap the name as short as
possible.

Printer niame:

peon Stvus COLOR 740 ESC/P 2

o )]
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TCP/IP Printing for Windows 2000 (continued)

Select Do not share this printer.

Click Next.

Select Yes to print a test page.

Click Next.

Click Finish.

The printer is now ready for
printing with Windows
2000 on your network.

Add Printer Wizard -

Prntes Shating
Vou can shaee Bus porkes veth cther netwers users

Indicate whether pou want thes printer to be avalable to other users If you share this
pinler, you sl picads & share name

& D not share this printer
(" Share as

|I-D_.Ym1 ]

< Back

tiet> |

Add Printer Wizard |

Print Test Page
Ta caniem that the panler & rstaled propedy. you can pork 2 lest page

Do you want to pant 3 test page?
& Hed

Mg

Add Printer Wizard

Completing the Add Printer
Wizard

You have successiully completed the Add Printer Wizard.
“r'ou specified the fallowing printer settings:

Mame: HF Laser)et
Share name:  <MNot Shared:
Port: IP_192166.010

Modet HF Lazerlet 4000 Series PCL
Default: Mo
Testpage: Mo

To close this wizard, click Finish

< Back Cancel
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TCP/IP Printing for Windows 98SE/Me

Open the web browser, and type in the IP address of the DP-301P+.
Type http://192.168.0.10 into the Location or Address field. Press Enter.

Note:

The PC'’s IP address must be in the same subnet as the print server’s IP
address for the two devices to communicate. (For example, if your print
server’s IP address is 192.168.0.10, with a subnet mask of 255.255.255.0,
then your computer’s IP address should be 192.168.0.x, where x is a value
between 1-254, excluding 10.) See Networking Basics: Assigning a Static IP
Address in this manual to find out how to change an IP address.

File Edit wiew Favorites  Tools  Help

Q- @ - ¥ B &

Address | €] http://192.168.0.10

DP-301P+
Focket Size Print Server

[ confgurationd _Tools 1 Help__J

Printer Speed High
Frintar Status Off ke

Tkl Print £iz 0 kit

Feinting E1as i

Sung St 0 Bes
Printing Size 0 Byses

1008 Bips

e Fagkuts
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TCP/IP Printing for Windows 98SE/Me
(continued)

At the Configuration window, write down the Port Name for future reference.
You will need this information later in the configuration process. The Port Name
shown here is only an example.

D > ] :
Building N!on!kslf}hor!.e DP-301P+
Pocket Size Print Server

-Ml Configuration -!l!l.

O ‘1_"‘ : System Device
e S S ——
"'h-u‘p Server Mame : |ESE@_1 |
Location i | |
Adrmin Contact 1 | |
System P —
= Password o Mew Password -
Caonfirm Again - | |
— ;
Network
Port Setting
. PortName . |PS-5321D1-P1
User
Description .
P Speed . |High »
SHMP —_"J
P.L Printer [Na |
Apply Cancel
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TCP/IP Printing for Windows 98SE/Me(continued)

When you select TCP/IP Protocol at the Network window, the screen below
appears. (We recommend that you keep the default settings as shown.) If you
need to make changes, make sure to click Save after you have made the
changes. (You may wish to make a note of the IP address.)

D-Link

Building Networks for People DP-301P+
Pocket Size Print Server

> Configuration [EITTSN NPT

el B TCPIP
IP Address

| @ Manually Assign

=) .
-
IP Address »192.168.0.10
SubnetMask - [256 72552550 |
System e =
Default Gateway - |0.0.0.0
| OAutomaticallyAssign
DMS Server Address 1 iU.U.U.U
e
2, (0.0.0.0
User UPnP © @Enable O Disable

MAC Rendezvous © @ Enable O Disable
SHMP secondHTTP Part © O Enanle @ Disable

Fart Murnber : 'D

(Far Remote Wéb Configuration and IPP Printing)

Network

U

Microsoft Network

Workgroup - [workGROUP |

AppleTalk

AppleTalk Zone i

LPT . hooser Mame D PE-592101-P1
Printer Twpe 5 Ease@ter 1
PastSeript Level : ILeveIZ VI
Font Group : @gnd@_j&_\'.i

2 ©

Apply Cancel
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TCP/IP Printing for Windows 98SE/Me (continued)

Configuration I Identificatinnl Access Enntmll

Go to Start > Settings > The following network. components are installed:
Control Panel. Elient for Microsoft Metworks

B8 D -Link DWL-650 11Mbps 'WLAN Adapter

4 IF</SP=-compatible Protocal

G TCRAP

E:'. File and printer sharing for Microzaft Metworks

Double-click on Network.

The screen shown at the
right will appear.

Add... | Fiermae | Broperties |

Click Add.

Frimany Metwork Logon:
Client for Microzoft Metworks j

File and Frint Shanng... R!

Drescription

ok I Cancel |

Select Network Component Type

Highlight Client.

Click Add.

_ﬁm&rtmuhlumwlmbw';dbdu
compubars.
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TCP/IP Printing for Windows 98SE/Me (continued)

At this window, = muwﬁmmmmumgmmoumm
click Have Disk. i S

Manufachurers: Network Clents:

1. Insert the DP-301P+
CD-ROM into your
CD-ROM drive.
Select the letter
representing the
CD-ROM drive on Open

your computer from Fie pame Folders:
the pull-down menu. Jiecird oV 4
(] [ g

2. Double-click on 3 k)2 Network. . |
the folder Ipr.

3. Highlight Ipr.inf.

4. Click OK.

location of the file.

Click OK to accept the Insest the marvufacturer's instalation disk into m
; ] - the ditva salacted, and then cick OK.
Cancel

Copy manufacturer's Hes hiom

[G:ALFR =] Broaves... |
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TCP/IP Printing for Windows 98SE/Me (continued)

Click OK.
[ ok ]| Cconce |

You should now be Network 2| x|

back to the Network Configuration I Identiﬁcatianl Acoess Eontmll
Properties Page.
Highlight LPR for
TCP/IP Printing.

The following network, components are installed:

| et for Microsaft Metworks
B8 D-Link D'wWL-650 11Mbps WLAN Adapter
i IFH/SPe-compatible Protocol

Add... | Remove | Properties |
Click Pro pertles. Frirmary Metwork. Logon:
Client for Microzoft Metworks j

File and Print Sharing... i

Description

(4 I Cancel
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TCP/IP Printing for Windows 98SE/Me (continued)

LPR fos TCP/IP Printing Propertie | X

—_—

Click Add Port. -

Type in the IP address of
the DP-301P+. Make sure Add Port

the Port Name is accu- Adkires
rate. (The Port Name at 192168010

right is just an example.)

PS-116688-P1

Click OK. e

The Port Name and IP
address will be displayed.
(The Port Name at right is

. 192.168.0.10/PS-116688-P1
just an example.)

Click OK.




TCP/IP Printing for Windows 98SE/Me (continued)

Configuration | Identificatinnl Arccess Eu:untr-:ull

T he following netwaork, components are installed:

1 Clicnt for Microsoft Networks

S8 D-Link DwWL-B50 11 Mbps WLAN Adapter
i |P=/SPE-compatible Protocaol

= File and printer gharing for Microzoft Metworkz

Add... | R iErmie | Eroperties |

Prirmary Metwaork Logon:
Client for Microzoft Metworks j

File and Frint Sharing... A

Crezcription

Click OK. Cancel

Windows will ask System Settings Change
for a restart.

P Wou must restart wour computer before the new settings will kake effect.
-

Do wou want ko restark your compuker now?

Click Yes.
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TCP/IP Printing for Windows 98SE/Me (continued)

Once your computer has rebooted, click on
Start > Settings > Printers > Add Printer

Add Printer Wizard

Ttig;iaufduﬂhelpywtu irstall your printer quickly ard
eagly.

To begn instaling your printer, chck Next:

When the Add Printer Wizard
screen appears, click Next.

Select Network Printer. oS s el S S

Ifitis directly attached to your computer. click Lwal
1F')mr!laer IF it is sttached to anolher computer. chck ik
ninber

" Local prirter
& Network printer

Click Next.

Type the network path or the gueue name of your printer.
If you don't know its name, chck Brovise to view avalable
retwork printers.

Type in the path, if you know it,
or click Browse.

Do you prnt from M5-D05-based programs ?
" Yes
& No

< Back | Mext > Cancel
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TCP/IP Printing for Windows 98SE/Me (continued)

At the next screen, browse for the printer
port. Highlight the port as shown. (The Port
Name in this window is just an example.)

Click OK.

If the network path is not specified, type in
the IP address of the DP-301P+ and the
Port Name. (The Port Name shown at right
is just an example.)

Select Yes or No, to answer the question:
Do you print from MS-DOS based pro-
grams?

Click Next.

Highlight the printer, as shown. If the desired
printer is not on the list, click Have Disk and
insert the printer driver disk that came with
your printer to install the printer drivers.

Click Next.

Click Next.

46

Select the netword. pinter that add
Note: Prrters are usuely attached to computers.
T& MNetwork, Neghbodood
= W Entre Network
< &4 Piirt Setvers - TCPAP LFR
Q 182.163.0.1

7] PS-116688-P1

netvezel. prirders.
= Nebwor. path or quews rarme
[ 192.168.0.10\PS-116688-P1
" Doyou pant rsen MS DOS based programe ¥
Yo
& lo
< Bock. Cancel

& Chck the marufactuner snd mo

instaletion dick, clek. Have Disk por
dacumentabon o 3 compahble prrte:

My Eyinders:

Fugts [HE Lasecer 151

Gﬁc.h = [P Lanoehot 115 FostSenpt =
Gavere = i O
Gashetnge (HP Lasgslet 10

Haimes P Laseclet D FS Cartidoe -

[HP Laseutet IF
1R :I WP | acenlest IIF Pl =
_cao (o) o |




TCP/IP Printing for Windows 98SE/Me (continued)

Add Printer Wizard

Select Yes to print
a test page.

Click Finish.

Go to Start >
Settings > Printers
Check to see that your
printer is installed.

This folder contains information
about your current pnnters and a
wizard 10 help you install new
ones.

To get information about a
pnnter that's already installed,
nght-click the pnnter's icon.

To install a new pnnter, click Add
Printer to start the Add Printer
m!.ﬂd.

Select an item to view its
description,

a7



Unix/Linux Printing

Please refer to the PS Admin Manual on the CD included with your DP-301P+
purchase for information on setting up the print server in Unix/Linux.

48



Setting up Apple Talk or LPR
Printing in Mac OS X

l Note: Mac OS printing is supported by PostScript printers only! l

With Mac OS X you can use AppleTalk or LPR printers using IP protocols for printing
through print servers. Follow the instructions below to set up the print server.

After attaching the print server to your network using the directions provided in the
Quick Installation Guide, change the IP address of your Macintosh to access the
print server’s Web configuration.

Internet & Network

Open your System
Preferences @ @ @ I’ /
window and click - .

Network. Internet Network QuickTime Sharing
Atthe Configure 29~ Mctwack =

pull-down menu, “« =A@ 2
Show All Displays Sound MNetwork Startup Disk
select Manually
Location: | Automatic ]

Show: | PCI Ethernet Slot C1 =

Manually -
[ —)

Configure v Using DHCP )
Using BootP

Jame Servers (Opti

IP Address: 192.168.10.7
(Provided by DHCP Server)

Subnet Mask: 255.255.255.0

Router: 192.168.10.1 Search Domalns. —(Oprioal)

DHCP Client ID:
(Optional)

Example: apple.com, earthlink.net
Ethernet Address: 00:50:ba:b0:00:05

@ Click the lock to prevent fuu&-.-'n'gu)-‘mp_ . R =) © Apply Now :
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Setting up Apple Talk or LPR Printing
in Mac OS X (continued)

‘80 Network

The default IP address - g [ 0 @

Of the prlnt server |S Show All D;;pla;s Sound Network Startup Disk

Domain Name Servers (Optionall

192.168.0.10. Manu- Location: = Automatic ﬂ
ally change your IP Show: | PCI Ethernet Slot C1 s

address to :
102.168.0.X, WHETEX el vVor PO P
is any number be- Configure: | Manually 5]
tween 1 and 254

(except 10 which is P Address: 192.168.0.19 |

the IP address of the

print server) The IP Subnet Mask: 255.255.255.0

Search Domains

(Optional)

addresses and Subnet Router: 192.168.10.1
mask shown here are

examples only.
Ethernet Address: 00:50:ba:b0:00:05

Example: apple.com, earthlink.net

@ Click the lock to prevent fu ‘i‘?ﬂm-o- : 7 iW Apply Now
‘80 Network
fr—
T i =
Select the AppleTalk - - 3 Q
. . . Show All Displays Sound Network Startup Disk
tab in this window '
and CheCk Make Location: = Automatic a
AppleTalk Active. Show:  PCI Ethernet Slot C1 s )
[ 1ep/ip | ppPo AppleTalk | |
' M Make AppleTalk Active '
Computer Name: david chen's Computer
{Can be changed in Sharing Preferences)
AppleTalk Zone: T
Configure:  Automatically ﬁ
) Apply Now

- Click the lock to prevent fu "I}fiﬁ-"-mp
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Setting up Apple Talk or LPR Printing
in Mac OS X (continued)

TextEdit Edit Format Window Help

New N

To print, open a document
and select File > Print

from the menu. Open... #®0 M
Open Recent b
Close #EW
Save 85
Save As... 385
Save All

Revert to Saved

o8P

Page Setup...

Select Edit Printer Printer: | v No Printer Selected f}
List from the Printer saved settings: (IR
dialog box. (o TvaE =
Copies: E # Collated
Pages: @ All
O From: 1 to: |1
@ (m‘ fClntd) "—Prmt-\‘
eo0e Printer List
Click Add Printer & T —— i Status

“oetere (Ao prmer 3 3)

51



Setting up Apple Talk or LPR Printing
in Mac OS X (continued)

Select the printing

protocol preferred, 7 AppleTalk Q
AppleTalk or LPR LPR Printers using IP )
Printers using IP. 58 -
In this example, "Name | Directory Services
AppleTalk has been Bl ps 116688P1 Laserwriter
selected.
Printer Model:  Auto Select... ﬁ

"_ Cancel 'Fm

AppleTalk protocol:

. 80e Printer List
After selecting - = Kind Status
AppleTalk the Port PS-116688-P1 Laserwriter

Name of the print
server will be dis-
played. The Port
Name shown here is 9
an example only.

Click on the port to
which the PostScript
printer is connected.

{ Delete * [ Add Printer_. |

Then select the printer model from the dialog box displayed here.
Click Add Printer and the printer port configuration is complete.
Select the printer port just configured in the print window.

Click Print to print your document.
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Setting up Apple Talk or LPR Printing
in Mac OS X (continued)

LPR Printers using IP
protocol: LPR Printers using IP a

When you select LPR —————
Printers using IP Proto-
col, this window will ap-

LPR Printer's Address: 192.168.0.10
Internet address or DMS name

pear.
[ Use Default Queue on Server
Type the IP address of the Queue Name: | PS-116688-P1
print server into the LPR
Printer’s Address field. Printer Model: | Generic D
"_ Cancel f“ 'Fm

In the Queue Name field, type in the Port Name of the post-script printer that is
connected to the print server. The Port Name illustrated here is only an example.
Select the printer model from the dialog box.

Select the printer model from the dialog box.

Click Add.

Close all print center windows, select the printer port that was just selected.

Click Print to print the document.

Click Add and the process is complete.
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Setting up AppleTalk Printing
iIn Mac OS 9

E Note: Mac OS printing is supported for Postscript printers only! ]

The AppleTalk network protocol is used with computers using the Macintosh
operating system. It can be used for network communications over standard
Ethernet or Fast Ethernet using the EtherTalk transport, or over a proprietary
LocalTalk transport.

Your print server can be used for network printing to PostScript printers. You can
print from any Mac OS computer connected to your Ethernet network, either
directly using an EtherTalk connection, or indirectly through a LocalTalk-to-EtherTalk
router.

NOTE: The chooser hame of a printer connected to one of the print server’s ports
is the same as its port name. If you are using AppleTalk printing, you will need to
make sure that every port name is unigue among all of the network printers in your
AppleTalk zone. The port names shown in this manual are examples only.

Setting up the print server for AppleTalk Printing

To set up your print server so that it can be used for AppleTalk printing:
B Make sure the AppleTalk protocol is enabled in your Macintosh.

B Change the IP address on one of the computers on your network to
192.168.0.x, where x is any number between 11-254, excluding 10.

B Type 192.168.0.10 into the address field of your web browser. 192.168.0.10 is
the default IP address of the DP-301P+.

B Select the Network tab and scroll to the bottom to the AppleTalk protocol
section.

B If your AppleTalk network is divided into AppleTalk zones, you will have to
specify which zone the print server should be in. You should locate the print
server in the same zone as most of the users who will be using it. If your
network is not divided into zones, the AppleTalk Zone field should contain a
single asterisk “*”.
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Printing from Mac OS Client Workstations

The exact procedure for selecting a PostScript printer connected to your print
server may vary slightly, depending on what printer driver version you are using.
The procedure described below assumes you are using the LaserWriter 8.

To choose a printer connected to your print server as your Mac OS
workstation’s default printer,

Open the chooser by selecting Chooser from the Apple menu.

Select the LaserWriter 8 icon on the left. Make sure that AppleTalk is set
to Active.

A list of all networked PostScript printers will be displayed:

0= (hooser——7—~————H

Select a PostScript Printer:
Double-click the name of 89 =] s t1668P1 |
the printer port you wish AppleShars Sl
to use. The printer ports @ n
Shown are examples Only Laserwriter Z00/L5 | Laserwriter 8

=3
Prewiew™
B @ Active
AfpleLalC () Inactive 7.6.2
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Printing from Mac OS Client Workstations (continued)

If you have not previously
set this printer as the
default, your computer
will prompt you for a
PostScript Printer
Description file. Choose
Select PPD.

Select the appropriate
printer description file for
your printer.

Click Open.

(If your printer is not listed,
click Generic to use a
generic printer
description.)

d b
— “Generic®

‘. Current Printer Description File (PPD) 5elected:

Auto Setup | ' Select PPD... I'
[ Printer Info ] [ Configure ]
Open

@ Printer Descriptions ¢J

~ Mame | Date Moditied |2
5 HP LagerJet 4riL 547401 =
&P HP LaserJet 4t1P 5/7/01
€ HP LaserJst 4P (300 dpi) 5/7/01
U HP Laserdet 451 (300 dpi) 57401
L] Epson Stylus COLOR 740ESC/P2 | 5/7/01 | |
€3 HP LaserJst 4¢ 547401 =

Use the Generic PostScript™ Printer Description file:

e

|

If you wish to access this setting in the future, you can use the Setup button in the

Chooser window.

The selected printer will become your computer’s default printer. You may need to
choose Page Setup in any applications you have open.
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Technical Specifications

Printer Connection

Printer Port: Parallel port

Bidirectional Communication: Hewlett-Packard PJL (Printer Job Language) standard
for bi-directional communication.

Network Connection
Network Standards: |IEEE 802.3 10Base-T Ethernet
Network Data Transfer Rate: 10/100 Mbps (megabits per second)

Network Connector: RJ-45 connector for 10Base-T Category 5 twisted-pair connection

Network Protocols

Ethernet Frame Types: 802.2, 802.3, Ethernet Il, SNAP (auto-switching)

Transport Protocols: TCP/IP, NetBEUI, AppleTalk/EtherTalk, LPR

TCP/IP Protocols Supported: BOOTP, SNMP, Telnet, TFTP, FTP, LPD, RARP, DHCP

Management and Diagnostics
Standard: SNMP

MIBs: MIB-II (RFC 1213)

Diagnostic LED Indicators: Pw, Lk/Act, LPT

Environmental and Physical

Power Supply: External power supply providing 5V DC, 2.5A
Dimensions: 3.54" x 2.20" x 1.02" (90mm x 56mm x 26mm)
Weight: approx. 4.27 0z. (1219)

Operating Temperature: 32t0122°F (0 to 50°C)

Storage Temperature: -13to 131°F (-25 to 55°C)

Humidity: 5% to 95% non-condensing

Emissions: FCC Class B, CE Class B, VCCI Class B

Warranty
One year limited warranty
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Technical Support

You can find software updates and user documentation on the D-Link website.

D-Link provides free technical support for customers within the United States and within
Canada for the duration of the warranty period on this product.

U.S. and Canadian customers can contact D-Link technical support through our website,
or by phone.

Tech Support for customers within the United States:

D-Link Technical Support over the Telephone:
(877)453-5465
24 hours a day, seven days a week.

D-Link Technical Support over the Internet:
http://support.dlink.com
email:support@dlink.com

Tech Support for customers within Canada:

D-Link Technical Support over the Telephone:
(800) 361-5265
Monday to Friday 8:30am to 9:00pm EST

D-Link Technical Support over the Internet:
http://support.dlink.ca
email:support@dlink.ca

When contacting technical support, please provide the following information:
* Serial number of the unit
* Model number or product name

« Software type and version number
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Warranty and Registration
(USA only)

Subject to the terms and conditions set forth herein, D-Link Systems, Inc. (“D-Link”) provides this Limited
warranty for its product only to the person or entity that originally purchased the product from:

. D-Link or its authorized reseller or distributor and

. Products purchased and delivered within the fifty states of the United States, the District of
Columbia, U.S. Possessions or Protectorates, U.S. Military Installations, addresses with an APO or
FPO.

Limited Warranty: D-Link warrants that the hardware portion of the D-Link products described below will
be free from material defects in workmanship and materials from the date of original retail purchase of the
product, for the period set forth below applicable to the product type (“Warranty Period”), except as otherwise
stated herein.

1-Year Limited Warranty for the Product(s) is defined as follows:

. Hardware (excluding power supplies and fans) One (1) Year
. Power Supplies and Fans One (1) Year
. Spare parts and spare kits Ninety (90) days

D-Link’s sole obligation shall be to repair or replace the defective Hardware during the Warranty Period at no
charge to the original owner or to refund at D-Link’s sole discretion. Such repair or replacement will be
rendered by D-Link at an Authorized D-Link Service Office. The replacement Hardware need not be new or
have an identical make, model or part. D-Link may in its sole discretion replace the defective Hardware (or any
part thereof) with any reconditioned product that D-Link reasonably determines is substantially equivalent (or
superior) in all material respects to the defective Hardware. Repaired or replacement Hardware will be
warranted for the remainder of the original Warranty Period from the date of original retail purchase. If a
material defect is incapable of correction, or if D-Link determines in its sole discretion that it is not practical to
repair or replace the defective Hardware, the price paid by the original purchaser for the defective Hardware
will be refunded by D-Link upon return to D-Link of the defective Hardware. All Hardware (or part thereof) that
is replaced by D-Link, or for which the purchase price is refunded, shall become the property of D-Link upon
replacement or refund.

Limited Software Warranty: D-Link warrants that the software portion of the product (“Software”) will
substantially conform to D-Link’s then current functional specifications for the Software, as set forth in the
applicable documentation, from the date of original retail purchase of the Software for a period of ninety (90)
days (“Warranty Period”), provided that the Software is properly installed on approved hardware and
operated as contemplated in its documentation. D-Link further warrants that, during the Warranty Period, the
magnetic media on which D-Link delivers the Software will be free of physical defects. D-Link’s sole obligation
shall be to replace the non-conforming Software (or defective media) with software that substantially
conforms to D-Link’s functional specifications for the Software or to refund at D-Link’s sole discretion. Except
as otherwise agreed by D-Link in writing, the replacement Software is provided only to the original licensee,
and is subject to the terms and conditions of the license granted by D-Link for the Software. Software will be
warranted for the remainder of the original Warranty Period from the date or original retail purchase. If a
material non-conformance is incapable of correction, or if D-Link determines in its sole discretion that it is not
practical to replace the non-conforming Software, the price paid by the original licensee for the non-
conforming Software will be refunded by D-Link; provided that the non-conforming Software (and all copies
thereof) is first returned to D-Link. The license granted respecting any Software for which a refund is given
automatically terminates.

Non-Applicability of Warranty: The Limited Warranty provided hereunder for hardware and software of
D-Link’s products will not be applied to and does not cover any refurbished product and any product
purchased through the inventory clearance or liquidation sale or other sales in which D-Link, the sellers, or the
liquidators expressly disclaim their warranty obligation pertaining to the product and in that case, the product
is being sold “As-Is” without any warranty whatsoever including, without limitation, the Limited Warranty as
described herein, notwithstanding anything stated herein to the contrary.

Submitting A Claim: The customer shall return the product to the original purchase point based on its return

policy. In case the return policy period has expired and the product is within warranty, the customer shall
submit a claim to D-Link as outlined below:
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. The customer must submit with the product as part of the claim a written description of the
Hardware defect or Software nonconformance in sufficient detail to allow D-Link to confirm the
same.

. The original product owner must obtain a Return Material Authorization (“RMA”) number from the
Authorized D-Link Service Office and, if requested, provide written proof of purchase of the
product (such as a copy of the dated purchase invoice for the product) before the warranty service
IS provided.

. After an RMA number is issued, the defective product must be packaged securely in the original or
other suitable shipping package to ensure that it will not be damaged in transit, and the RMA number
must be prominently marked on the outside of the package. Do not include any manuals or
accessories in the shipping package. D-Link will only replace the defective portion of the Product
and will not ship back any accessories.

. The customer is responsible for all in-bound shipping charges to D-Link. No Cash on Delivery
(“COD") is allowed. Products sent COD will either be rejected by D-Link or become the property of
D-Link. Products shall be fully insured by the customer. D-Link will not be held responsible for any
packages that are lost in transit to D-Link. The repaired or replaced packages will be shipped to the
customer via UPS Ground or any common carrier selected by D-Link, with shipping charges
prepaid. Expedited shipping is available if shipping charges are prepaid by the customer and upon
request.

. Return Merchandise Ship-To Address

USA: 53 Discovery Drive, Irvine, CA 92618

Canada: 2180 Winston Park Drive, Oakville, ON, L6H 5W1 (Visit http://www.dlink.ca for detailed
warranty information within Canada)

D-Link may reject or return any product that is not packaged and shipped in strict compliance with the foregoing
requirements, or for which an RMA number is not visible from the outside of the package. The product owner
agrees to pay D-Link’s reasonable handling and return shipping charges for any product that is not packaged
and shipped in accordance with the foregoing requirements, or that is determined by D-Link not to be defective
or non-conforming.

What Is Not Covered: This limited warranty provided by D-Link does not cover: Products, if in D-Link's
judgment, have been subjected to abuse, accident, alteration, modification, tampering, negligence, misuse,
faulty installation, lack of reasonable care, repair or service in any way that is not contemplated in the
documentation for the product, or if the model or serial number has been altered, tampered with, defaced or
removed; Initial installation, installation and removal of the product for repair, and shipping costs; Operational
adjustments covered in the operating manual for the product, and normal maintenance; Damage that occurs in
shipment, due to act of God, failures due to power surge, and cosmetic damage; Any hardware, software,
firmware or other products or services provided by anyone other than D-Link; Products that have been
purchased from inventory clearance or liquidation sales or other sales in which D-Link, the sellers, or the
liguidators expressly disclaim their warranty obligation pertaining to the product. Repair by anyone other than
D-Link or an Authorized D-Link Service Office will void this Warranty.

Disclaimer of Other Warranties: EXCEPT FOR THE LIMITED WARRANTY SPECIFIED HEREIN, THE
PRODUCT IS PROVIDED “AS-IS” WITHOUT ANY WARRANTY OF ANY KIND WHATSOEVER INCLUDING,
WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY, FITNESS FOR APARTICULAR PURPOSE
AND NON-INFRINGEMENT. IFANY IMPLIED WARRANTY CANNOT BE DISCLAIMED INANY TERRITORY WHERE
APRODUCT IS SOLD, THE DURATION OF SUCH IMPLIED WARRANTY SHALL BE LIMITED TO NINETY (90)
DAYS. EXCEPTAS EXPRESSLY COVERED UNDER THE LIMITED WARRANTY PROVIDED HEREIN, THE ENTIRE
RISKAS TOTHE QUALITY, SELECTION AND PERFORMANCE OF THE PRODUCT IS WITH THE PURCHASER OF
THEPRODUCT.

Limitation of Liability: TO THE MAXIMUM EXTENT PERMITTED BY LAW, D-LINK IS NOT LIABLE UNDER
ANY CONTRACT, NEGLIGENCE, STRICT LIABILITY OR OTHER LEGAL OR EQUITABLE THEORY FORANY
LOSS OF USE OF THE PRODUCT, INCONVENIENCE OR DAMAGES OF ANY CHARACTER, WHETHER DIRECT,
SPECIAL, INCIDENTAL OR CONSEQUENTIAL (INCLUDING, BUT NOT LIMITED TO, DAMAGES FOR LOSS OF
GOODWILL, LOSS OF REVENUE OR PROFIT, WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION,
FAILURE OF OTHER EQUIPMENT OR COMPUTER PROGRAMS TO WHICH D-LINK'S PRODUCT IS CONNECTED
WITH, LOSS OF INFORMATION OR DATACONTAINED IN, STORED ON, OR INTEGRATED WITHANY PRODUCT
RETURNED TO D-LINK FOR WARRANTY SERVICE) RESULTING

FROM THE USE OF THE PRODUCT, RELATING TO WARRANTY SERVICE, ORARISING OUT OFANY BREACH
OF THIS LIMITED WARRANTY, EVEN IF D-LINK HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES. THE SOLE REMEDY FOR A BREACH OF THE FOREGOING LIMITED WARRANTY IS REPAIR,
REPLACEMENT OR REFUND OF THE DEFECTIVE OR NON-CONFORMING PRODUCT. THE MAXIMUM
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LIABILITY OF D-LINK UNDER THIS WARRANTY IS LIMITED TO THE PURCHASE PRICE OF THE PRODUCT
COVERED BY THE WARRANTY. THE FOREGOING EXPRESS WRITTEN WARRANTIESAND REMEDIES ARE
EXCLUSIVE AND ARE IN LIEU OF ANY OTHER WARRANTIES OR REMEDIES, EXPRESS, IMPLIED OR
STATUTORY.

Governing Law: This Limited Warranty shall be governed by the laws of the State of California. Some states
do not allow exclusion or limitation of incidental or consequential damages, or limitations on how long an implied
warranty lasts, so the foregoing limitations and exclusions may not apply. This limited warranty provides
specific legal rights and the product owner may also have other rights which vary from state to state.

Trademarks: D-Link is a registered trademark of D-Link Systems, Inc. Other trademarks or registered
trademarks are the property of their respective manufacturers or owners.

Copyright Statement: No part of this publication or documentation accompanying this Product may be
reproduced in any form or by any means or used to make any derivative such as translation, transformation,
or adaptation without permission from D-Link Corporation/D-Link Systems, Inc., as stipulated by the United
States Copyright Act of 1976. Contents are subject to change without prior notice. Copyright® 2002 by D-Link
Corporation/D-Link Systems, Inc. All rights reserved.

CE Mark Warning: This is a Class B product. In a domestic environment, this product may cause radio
interference, in which case the user may be required to take adequate measures.

FCC Statement: This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communication. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

. Reorient or relocate the receiving antenna.

. Increase the separation between the equipment and receiver.

. Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
. Consult the dealer or an experienced radio/TV technician for help.

For detailed warranty outside the United States, please contact corresponding local D-Link
office.

FCC Caution:

The manufacturer is not responsible for any radio or TV interference caused by unauthorized modifications to

this equipment; such modifications could void the user’s authority to operate the equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

IMPORTANT NOTE:

FCC Radiation Exposure Statement:

This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment. The
antenna(s) used for this equipment must be installed to provide a separation distance of at least eight
inches (20 cm) from all persons.

This equipment must not be operated in conjunction with any other antenna.

[ Register your D-Link product online at http://support.dlink.com/register/ ]
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Appendix:

DP-301P+ Printer Compatibility List

The Canon Printer
Canon BJC-255SP
Canon BJ-330

Canon BJC-600, 620
Canon BJC-2000SP
Canon BJC-4100, 4300, 4500, 4550
Canon BJC-6000, 6500
Canon BJC-7000
Canon BJC-8200
Canon LBP-720, 740
Canon Bubble Jet S520

The Epson Printer/plotter
Epson Stylus Photo 700, 710, 750

Epson Stylus Photo 870

Epson Stylus Photo 1200, 1270
Epson Stylus Photo EX

Epson Stylus Pro XL

Epson Stylus Color 400, 440, 460, 480
Epson Stylus Color 600, 640, 660
Epson Stylus Color 740

Epson Stylus Color 800, 850, 860
Epson Stylus Color 900

Epson Stylus Color 1160

Epson Stylus Color 1500, 1520
Epson Stylus Color 3000

Epson Stylus C60

Epson LQ-100

Epson LQ-300

Epson LQ-550, 570+

Epson LQ-1070C+

Epson LQ-2070, 2170C

Epson EPL-N2000, N2010

Epson EPL-5500, 5700, 5700L, 5800
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The Fujitsu Printer
Fuiji 10V, 14V

Fuji DL-700

Fuiji DL-3800

The HP Printer/Plotter
HP Portable

HP LaserJet Il

HP LaserJet 4P, 4L, 4V

HP LaserJet 5L

HP LaserJet 6P, 6L

HP LaserJet 1100, 1100A
HP LaserJet 1200

HP LaserJet 2100, 2100M
HP LaserJet 2200

HP LaserColorJet 8500

HP DeskJet 400, 420

HP DeskJet 500, 550C, 560C
HP DeskJet 670C, 695C
HP DeskJet 720C

HP DeskJet 810C, 890C
HP DeskJet 920C

HP DeskJet 930C(new), 970CXI
HP DeskJet 1120C

HP DeskJet 1125C

HP DesignJet 350C

HP DesignJet 600C

HP LaserJet 4000

HP LaserJet 5000

HP OfficeJet T45, 710

The IBM Printer
IBM 5577

IBM 4039 16L

IBM Infor Printer 20
IBM InfoPrint 32




Appendix: DP-301P+ Printer Compatibility List (continued)

The Lexmark Printer
Lexmark 4039 10R
Lexmark 5700
Lexmark Optra Color 45
Lexmark Optra C710
Lexmark Optra E, E+, E310
Lexmark Optra K1220
Lexmark Optra M410, M412
Lexmark Optra N
Lexmark Optra R+
Lexmark Optra S1250, S1855
Lexmark Optra SC-1275
Lexmark Optra SE-3455
Lexmark Optra T614
Lexmark Optra W810
Lexmark Z53

The NEC Printer
NEC P2200
NEC P3200
NEC P5300
NEC P6300
NEC P7300

Other Printers
Brother HL-1260

CD T120

Citizen GSX-230
Futek 84+
OKIML-391

OKldata OL-400
Olivetti JP450
Panasonic 2023
Panasonic KX-P1624
Printtec PR856C
Star NX-2420
Tektronix Phraser 350

Other printers from the brands listed above may also be supported.

For an updated compatibility list please visit: http:/Mww.support.dlink.com

(03/01/2004)
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